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Prestigio Visconte 125W
User’s Manual

Notice
The company reserves the right to revise this publication or to change its contents without notice. Information contained
herein is for reference only and does not constitute a commitment on the part of the manufacturer or any subsequent vendor.
They assume no responsibility or liability for any errors or inaccuracies that may appear in this publication nor are they in
anyway responsible for any loss or damage resulting from the use (or misuse) of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or
reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this publication,
except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their
respective companies. They are mentioned for identification purposes only and are not intended as an endorsement of that
product or its manufacturer.

© April 2005
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Intel and Pentium are registered trademarks of Intel Corporation.
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury to persons
when using any electrical equipment:
1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement
or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may be
a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may explode.
Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (DC Output 65W minimum).

CAUTION
Always disconnect all telephone lines from the wall outlet before servicing or disassembling this
equipment.

Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:
1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged
Do not expose the computer to any shock or vibration.
Do not place it on an unstable surface.
Do not place anything heavy on the computer.
2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating element. This is
an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.
Do not expose it to excessive heat or direct sunlight.
Do not leave it in a place where foreign matter or moisture may affect the system.
Don’t use or store the computer in a humid environment.
Do not place the computer on any surface which will block the vents.
3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other strong magnetic
fields. These can hinder proper performance and damage your data.
4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget to save your
work. Remember to periodically save your data as data may be lost if the battery is depleted.
Do not turn off the power until you properly shut down all programs.
Do not turn off any peripheral devices when the computer is on.
Do not disassemble the computer by yourself.
Perform routine maintenance on your computer.
5. Take care when using peripheral devices.
Use only approved brands of peripherals.
Unplug the power cord before attaching peripheral devices.

Power Safety
The computer has specific power requirements:
• Only use a power adapter approved for use with this computer.
• Your AC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. If you
are unsure of your local power specifications, consult your service representative or local power company.
• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety feature;
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do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
• When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
• Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
• Before cleaning the computer, make sure it is disconnected from any external power supplies.
Do not plug in the power cord if you are wet.
Do not use the power cord if it is broken.
Do not place heavy objects on the power cord.

Power Safety Warning
Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all periph-
erals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally
turning the machine on.

Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified
service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries may
explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At
the end of its useful life, under various state and local laws, it may be illegal to dispose of this
battery into the municipal waste stream. Check with your local solid waste officials for details in
your area for recycling options or proper disposal.
Caution
Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent
type recommended by the manufacturer. Discard used battery according to the manufacturer’s
instructions.

Cleaning
Do not apply cleaner directly to the computer, use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the computer
to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply. Then refer
servicing to qualified service personnel under any of the following conditions:
• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
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• If there is an unusual odor, heat or smoke coming from your computer.

Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:
1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC adapter and cables. Stow them in the carrying bag.
5. The AC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, check with your
travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters and/or
cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware
and software. Make sure your “papers” are handy (it may be useful to have the computer in a sleep mode before going
through customs).

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting
a notebook which is powered on in a travel bag may cause the vents/intakes to be blocked. To prevent your computer from
overheating make sure nothing blocks the vent/fan intake while the computer is in use.

Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time. Improper
work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or other joints. The following
are some tips to reduce the strain:
• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level of your elbow. Keep your
forearms, wrists, and hands in a relaxed position.
• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a footrest if necessary.
• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles when you are working.
• Take periodic breaks if you are using the computer for long periods of time.
Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent and short breaks are better than
fewer and longer breaks.

Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and shoulders.
• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
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• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display viewing angle to find the best position.

Quick Start Guide

This guide assumes that you are already familiar with computers and can tell at a glance what and where all the key
components are. If you are not that comfortable with this type of device, then please refer to the following pages, which
give an overview of the system.
It is still best to review these steps, before taking any action. If there is anything you are not sure about, then please refer
to the appropriate chapter before continuing.
Unless you need to install an operating system, your computer should be ready to work right out of the box. Before you begin
please follow the safety instructions in the Preface.
1. Remove all packing materials, CDs/DVDs, floppy disks, and any PC Cards.
2. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
3. Attach the AC adapter to the DC-In jack at the rear of the computer (see “Right Side View”), then plug the AC power cord
into an outlet, and connect the AC power cord to the AC adapter.
4. Raise the lid/LCD to a comfortable viewing angle.
5. Press the power button to turn “on”.

Peripheral Devices
Please note that peripherals (printers, digital cameras, etc.) which attach to your computer by
USB ports may be connected after Windows is up and running. All other peripherals must be
connected before you turn on the system.

System Map

Your computer has a lot of built-in features. Most of these are enabled by your operating system. Further explanations of
the various subsystems are covered in the chapter or pages indicated.

Getting to Know Your Computer
The following pages will help you to become familiar with the basic functions, and to learn the location of the various ports
and components of your computer.
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Gloss Style Top Covers
Note the following guidelines for care and attention of the gloss style top cover incorporated within the design styles of this
notebook model.
• Remove the protective cover slowly and carefully. Do not forcibly tear off the protective cover as this may damage the
surface of the top cover.
• Do not use pointed objects on the surface of the top cover, and do not place objects on top of it.
• Do not expose the top cover to excessive heat or direct sunlight.
• Only use the soft cloth provided for cleaning the top cover, and do not use abrasive cleaners.

Top View

1. LCD Latches
2. LED Power Indicators

To open the LCD display:
1. Place the computer on a stable surface.
2. Move the LCD latches (1) in the direction of the arrows to release the top cover.
3. Lift the top cover to reveal the LCD panel and keyboard.
4. Adjust the LCD panel to a comfortable viewing angle.
5. The LED Power indicators (2) show the power and battery status of the computer.

Top View with LCD Panel Open

1

2

1
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1. Optional PC Camera
2. LCD Panel
3. 2 Built-In Speakers
4. LED Power Indicators
5. Power Button
6. Close Cover Switch
7. Keyboard
8. TouchPad and Buttons
9. Built-In Microphone
10. LED Status Indicators

PC Camera
If you have purchased the optional PC Camera, make sure you install the software application.

LCD Panel
The computer comes with a TFT (Liquid Crystal Display) screen.

Stereo Speakers
The two built-in speakers provide rich, stereo sound.

LED Power Indicators
These indicators display the computer’s system power status and battery status .

Power Button
Press this button to turn your computer on or off. This button may also be configured to be used as a suspend/resume key
in the power management control panel of your operating system.

Forced Off
If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power
button for 4 seconds, or longer, to force the system to turn itself off.

Close Cover Switch
This switch acts as a sensor to tell when the LCD Panel is closed. When this LCD cover sensor is activated, the default setting
of your operating system’s power scheme sends the computer into a power saving state.

Shutdown
Please note that you should always shut your computer down by choosing the Shut Down/Turn Off
Computer command from the Start menu in Windows. This will help prevent hard disk or system
problems.

Keyboard
The computer has a “Win Key” keyboard including a numeric keypad. It has the same features as a full-sized desktop keyboard
and can easily be replaced with a different language keyboard should you desire.

TouchPad & Buttons
The pointing device features a sensitive glide pad for precise movements. It functions the same way as a two-button mouse.
The right TouchPad button is the same as the right mouse button; the left TouchPad button is the same as the left mouse
button. The central button may be used to scroll up and down, or may be configured to perform a variety of functions.

Built-In Microphone
Record on your notebook computer with the built-in microphone.

LED Status Indicators
These display the system’s operational status.
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Front View

1. LCD Latches
2. Microphone-In Jack
3. Headphone-Out Jack
4. Infrared Transceiver

Microphone-In Jack
Record on your notebook computer with an external microphone.

Headphone-Out Jack
Headphones or speakers may be connected through this jack. Note: Set your system’s volume to a reduced level before
connecting to this jack.

Infrared Transceiver
The infrared transceiver enables communication between the computer and another similarly equipped device, and is 4M
bps FIR, IrDA 1.1 compliant.

Left Side View

1. Security Lock Slot
2. Vent
3. RJ-45 LAN Jack
4. RJ-11 Phone Jack
5. USB 2.0/1.1 Ports
6. PC Card Slot
7. PC Card Slot Eject Button

Overheating
To prevent your computer from overheating make sure nothing blocks the vent/fan outlet while
the computer is in use.

Security Lock Slot
To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store.

Vent
This enables airflow to prevent the notebook from overheating.

RJ-45 LAN Jack
This port supports LAN (Network) functions.

Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.
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RJ-11 Phone Jack
This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11 telephone connection.

Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

USB 2.0/1.1 Ports
These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice
or scanners, and for highspeed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices
can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power
rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device).

PC Card Slot
The 3.3V/5V slot may be used for a Type-II PC card (PC Cards were also previously referred to as PCMCIA) and fully supports Cardbus.

Right Side View

1. Optical Device Bay
2. External Monitor (VGA) Port
3. DC-In Jack

Optical Device Bay
The optical device bay will contain a 5.25" (12.7mm height) CD/DVD type device. The actual device will depend on your
purchase option.

CD Emergency Eject
If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption) you may
push the end of a straightened paper clip into the emergency eject hole. Do not use a sharpened
pencil or similar object that may break and become lodged in the hole.

External Monitor (VGA) Port
Connect an external VGA monitor (CRT) to this port to allow dual video or simultaneous display on the LCD and external
VGA monitor.

DC-In Jack
Plug the supplied AC adapter into this jack to power your notebook.

Bottom View
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1. Vent/Fan Outlet
2. Battery
3. Memory (RAM) Socket Cover
4. Hard Disk Cover
5. WLAN Module Cover
6. CPU Cover

CPU
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way,
may violate your warranty.
Overheating
To prevent your computer from overheating make sure nothing blocks the vent/fan outlet while
the computer is in use.

Hard Disk Drive
The internal hard disk drive is used to store your data.

Drive Warning
Don’t try to remove the hard disk (HDD) while the system is on. This could cause data loss or
damage. Unauthorized removal or tampering with the HDD may violate your warranty. If you are
in doubt, consult your service representative.

Wireless LAN (Network) & Bluetooth Modules
Your notebook computer will have either an Intel PRO/Wireless 2100 (802.11b) OR 2200BG (802.11b/g) Mini PCI Wireless
LAN module, and may have an optional Bluetooth module. The antenna and other components are not externally visible
(check with your service representative). Make sure you install the appropriate driver(s) for it/them. Make sure any wireless
module is OFF when you are using the computer aboard aircraft by using the appropriate key combination below.

Power Toggle for the Wireless LAN and Bluetooth Modules
You will need to enable power to the modules by using the following key combinations:
Fn + F11 = Wireless LAN Module Power Toggle
Fn + F12 = Bluetooth Module Power Toggle
When the Wireless LAN module is powered on, the LED will be green.
When the Bluetooth module is powered on, the LED will be orange.
Do not try to use the Wireless LAN module and the Bluetooth module at the same time, as this
may cause a communication conflict.

Wireless Device Operation Aboard Aircraft
The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make
sure the module(s) are OFF if you are using the computer aboard aircraft. When the computer
first ‘Boots Up’ the module(s) will be OFF.
If you restart the computer the power status of the module will remain the same as it was before
the restart. If you shut down the computer the module will turn OFF.
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Using The Computer

The Power Sources
The computer can be powered by either an AC adapter or a battery pack.

AC Adapter
Use only the AC adapter that comes with your computer. The wrong type of AC adapter will damage the computer and its
components.
1. Attach the AC adapter to the DC-in jack on the right of the computer.
2. Plug the AC power cord into an outlet, then connect the AC power cord to the AC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “on”.

Power Button as Standby or Hibernate Button
If you are using a fully ACPI-compliant OS, (such as Windows 2000 Professional, or Windows XP)
you can use the OS’s “Power Options” control panel to set the power button to send the system into
Standby or Hibernate mode.

Battery
The battery allows you to use your notebook computer while you are on the road or an electrical outlet is unavailable. Battery
life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge
completely before recharging.
We recommend that you do not remove the battery.

Recharging the Battery with the AC Adapter
The battery pack automatically recharges when the AC adapter is attached and plugged into an electrical outlet. If the
computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off
but plugged into an electrical outlet, battery charge time is less.

Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Battery Removal
We recommend that you do not remove the battery yourself. Please consult your service
representative should you need to remove the battery for any reason.
Low Battery Warning
When the battery is critically low, immediately connect the AC adapter to the computer or save
your work, otherwise, the unsaved data will be lost when the power is depleted.

Turning on the Computer
Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.
When the computer is on, you can use the power button as a Standby/Hibernate/Shutdown hot-key button when it is pressed
for less than 4 seconds (pressing and holding the power button for longer than this will shut the computer down). Use Power
Options in the Windows control panel to configure this feature.

Shutdown
Note that you should always shut your computer down by choosing the Shut Down/Turn Off Computer
command from the Start menu in Windows. This will help prevent hard disk or system problems.
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Forced Off
If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power
button for 4 seconds, or longer, to force the system to turn itself off.

LED Indicators
There are two sets of LED indicators (LED Power Indicators and LED Status Indicators) on your computer that will display
helpful information about the current status of the computer. The LED Power Indicators are also visible when the top of your
computer is closed.

LED Status Indicators

Icon Color Description

Green Hard Disk/CD/DVD device activity

Green Number Lock is activated

Green Caps Lock is activated

Green Scroll Lock is activated (to activate press Fn & ScrLk)

Green The Wireless LAN module is powered on
Orange The Bluetooth module is powered on

Green The computer is on
Blinking Green The computer is in standby mode

Orange The battery is being charged
Green The battery is fully charged
Blinking Orange The battery has reached critically low power status

Communication Conflict
Do not try to use the Wireless LAN module and the Bluetooth module at the same time, as this
may cause a communication conflict.

Scroll Lock
To enable and disable the Scroll Lock feature, press the Fn and ScrLk keys simultaneously.

Hard Disk Drive
The hard disk drive is used to store your data in the notebook computer. The hard disk can be taken out to accommodate
other 2.5" IDE hard disk drives with a height of 9.5 mm.
The hard disk (1) is accessible from the bottom of your computer as seen below.
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Power Safety
Before attempting to access any of the internal components of your notebook please ensure that
the machine is not connected to the AC power, and that the machine is turned off. Also ensure that
all peripheral cables, including phone lines, are disconnected from the computer.

Optical Device
The optical device bay will contain a 5.25" CD-ROM/DVD type optical device. The actual device type will depend on the option
you purchased. The CD Device is usually labeled “Drive D:”, and may be used as a boot device if properly set in the BIOS.

Loading Discs
To insert a CD/DVD, press the open button (1) and carefully place a CD/DVD onto the disc tray with label-side facing up (use
just enough force for the disc to click onto the tray’s spindle).
Gently push the CD/DVD tray in until its lock “clicks” and you are ready to start. The busy indicator (2) will light up while data
is being accessed, or while an audio/video CD, or DVD, is playing.
If power is unexpectedly interrupted, insert an object such as a straightened paper clip into the emergency eject hole (3) to
open the tray.

Sound Volume Adjustment
How high the sound volume can be set depends on the setting of the volume control within
Windows. Click the Volume icon on the taskbar to check the setting.
All peripherals must be connected before you turn on the system.

Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged.
Please follow the advice below to make sure that the data stored on your CDROMs/DVD-ROMs can be accessed.
Remember to:
• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.

DVD Regional Codes
DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection
is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.
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Changing DVD Regional Codes
Go to the Control Panel in WindowsXP/Windows 2000 and double-click System > Hardware (tab), click Device Manager, then
click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties menu, and select
the DVD Region (tab) to bring up the control panel.

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South Africa, Middle East & Egypt

3 South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong

4 South & Central America, Mexico, Australia, New Zealand

5 N Korea, Russia, Eastern Europe, India & Most of Africa

6 China

PC Card Slot
The computer is equipped with a PCMCIA 3.3V/5V slot for one type II PC Card. Make sure you install the driver for the PC
Card.

Inserting and Removing PC Cards
• Align the PC Card with the slot and push it in until it locks into place.
• To remove a PC Card, simply press the eject button (1) next to the slot.

Conserving Battery Power
To conserve battery power remove any unused PC Cards from the computer (PC Cards quickly use
up battery power even if the system enters sleep mode).

The Keyboard
Function Keys

On the bottom-left of the keyboard is the Fn key or Function key. The Fn key allows you to change operational features
instantly. To use the functions press and hold the Fn key, then press the appropriate function key (F3 - F9 etc.) located on your
keyboard.

Keys  Description

Fn Function Key

Fn + F3 Mute Toggle

Fn + F4 Sleep/Resume Toggle

Fn + F5 Decrease Audio Volume

Fn + F6 Increase Audio Volume

Fn + F7 Display Toggle

Fn + F8 Decrease LCD Brightness

Fn + F9 Increase LCD Brightness
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Keys  Description

Fn + F11 Wireless LAN Module Power Toggle

Fn + F12 Bluetooth Module Power Toggle

Fn + ScrLk Scroll Lock Toggle

Other Keyboards
If your keyboard is damaged or you just want to make a change, you can use any standard USB
keyboard. The system will detect and enable it automatically. However special functions/hot keys
unique to the system’s regular keyboard may not work.

Numeric Keypad
The keyboard has an embedded numerical keypad for easy numeric data input. Activate the Number Lock feature by
pressing the Fn and Num Lk key combination. You may check if Number Lock is enabled or not by looking at the LED status
indicators. To type a number from the numeric keypad make sure Num Lk is enabled, and then press the key on the numeric
keypad. (To type a letter from the numeric keypad if Num Lk is enabled, hold down the Fn key and press the appropriate
letter key.)
Activate Scroll Lock by pressing the Fn and Scr Lk key combination.

Special Characters
Some software applications allow the number-keys to be used with Alt to produce special
characters. These special characters can only be produced by using the numeric keypad. Regular
number keys (in the upper row of the keyboard) will not work. Make sure that Num Lock is on.

TouchPad and Buttons/Mouse
The TouchPad is a device for pointing (controlling input positioning) on the computer’s display screen by sensing finger
movement, and downward pressure. It is an alternative to the mouse; however, you can also add a mouse to your computer
through one of the USB ports.
The TouchPad buttons function in much the same way as a two-button mouse. Once you have installed the TouchPad drivers
you can configure the functions by double-clicking the TouchPad driver icon on the taskbar, or by going to the Mouse control
panel in Windows (Start menu and point to Settings and click Control Panel, then double-click the Mouse icon). In Windows
XP the Mouse control panel is in the Printers and Other Hardware Category.
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Mouse Driver
If you are using an external mouse your operating system may be able to auto-configure your
mouse during its installation or only enable its basic functions. Be sure to check the device’s user
documentation for details.

Configuring the Infrared Transceiver
To configure the computer’s settings for Fast Infrared (FIR) communication follow these steps:
1. Click Start, point to Settings (or just click Start and click Control Panel) and click Control Panel.
2. Double-click Wireless Link (in the Printers and Other Hardware Category) icon.
3. Click Hardware (tab), and then click Properties (button).
4. Select Advanced (tab).
5. Select “Infrared Transceiver A” and change the Value to “HP HDSL-2300/3600”.
6. Click OK > OK.
The infrared transceiver may be enabled/disabled in the BIOS.
For further information, please refer to the manual of the device you wish to connect.

Infrared Communication
The infrared transceiver operates on a “Line of Sight”.
Make sure nothing is blocking the “Line of Sight” between your system’s transceiver and the
destination’s transceiver.

Adding a Printer
The most commonly used peripheral is a printer. The following conventions will help you to add a printer, however it is always
best to refer to the printer manual for specific instructions and configuration options.

USB Printer
Most new printers have a USB interface connection. You may use any of the USB ports on your computer to connect the
printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink cartridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen
instructions.

Parallel Printer
This is still a very common type of printer. A Parallel to USB converter may be purchased at most computer stores.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ ink cartridge etc.).
2. Attach the parallel cable to the printer.
3. Connect the printer’s parallel cable to the Parallel to USB converter, and then plug the converter into the USB port.
4. Turn ON the printer.
5. Turn ON the computer.
6. Windows (some operating systems may require a driver to recognize the parallel to USB adapter) will identify the printer
and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.
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Advanced Controls

Note: All operating system pictures in this manual are from the Microsoft Windows XP OS.

Advanced Video Controls
This section is about making adjustments for the LCD, and switching display devices.

Opening the LCD
As you open the lid, adjust it so you can look at the screen straight on, without any glare. If necessary, adjust the brightness
controls (Fn + F8/F9). The Fn + F7 key combination allows you to toggle through display options if you have a monitor
attached.

Protecting the LCD
Do not allow any foreign objects (i.e. paper or plastic) to get between the lid/LCD and the work
panel. They could damage or scratch the LCD and/or accidentally activate the close cover switch.

Dynamic Video Memory Technology
Intel® DVMT automatically and dynamically allocates as much (up to 64MB) system memory (RAM) as needed to the video
system. DVMT returns whatever memory is no longer needed to the operating system.

System Memory Maximum Memory Allocated for Graphics by DVMT

0MB - 127MB Not Supported

128 MB - 255MB 32MB

256MB - Maximum Memory 64MB

Information Tab
The information tab in the Intel(R) 82852/82855 GM/GME Graphics Controller Properties lists
details of your computer’s memory etc.

DVMT Notes
DVMT is not user-configurable.
DVMT is not local video memory.
DVMT will not function in MS-DOS. DOS uses the legacy memory indicated.
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Video Driver Controls
The video interface lets you change the screen resolution and color output to whatever is most comfortable/efficient for
you. This is a matter of hardware, video memory and the driver for your operating system. The driver interface shows the
available options.
You can switch display devices from the Display Properties control panel in Windows as long as the video driver is installed.

Screen Resolution/Screen Area Note
You may set the resolution to a higher setting than the panel supports, however this will require
you to pan (scroll) around the screen as the display area will be larger than what you can see on
the LCD.

Making Adjustments for the Display
The higher the resolution you set the LCD for, the more information the LCD can display on screen. To change the LCD’s
resolution and color depth go to the Display Properties control panel:
1. Click Start, point to Settings (or just click Control Panel) and click Control Panel (if you are in Category View choose
Appearance and Themes).
2. Double-click Display (icon).
3. In the Display Properties dialog box, click Settings (tab).
4. In Screen area/Screen resolution, move the slider to the preferred setting for resolution.
5. In Colors/Color quality, click the arrow and scroll to the preferred setting for color depth.

Display Properties
When the Display Properties control panel is open, click the Advanced (button) to bring up the options tabs. Clicking through
these tabs allows you to make any video adjustments you require.
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Intel(R) Extreme Graphics Controller Properties
You can click Graphics Properties (button) in the Intel(R) Extreme Graphics tab (in the Advanced options).

Intel Video Driver Controls
After installing the video driver there will be an additional control panel entitled Intel(R) Extreme Graphics. To get to the
control panel to make changes to the Graphics Properties, do the following:
1. Click Start, point to Settings (or just click Control Panel) and click Control Panel.
2. Double-click Intel(R) Extreme Graphics (icon) to bring up the Intel(R) 82852/82855 GM/GME Graphics Controller Proper-
ties.

Taskbar
You can also access the control panel from the taskbar. Click on the icon to bring up the menu and
scroll to Graphics Options > Graphics Properties.
If you cannot see the tray icon go to the Intel(R) Extreme Graphics 2 for Mobile tab (in the
Advanced options) and click the “Show Tray Icon” tickbox.

You may make changes to the Devices, Color, Schemes and Hot Keys by clicking the appropriate tab and adjusting the setting,
then by clicking OK. The Information and Open GL tabs display useful information about the graphics properties of your
computer, and the Support item in the Information tab has weblinks to the latest information (drivers, troubleshooting issues
etc.) on the Intel Website. Screen examples are shown below.
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Schemes
Use Schemes to configure quick settings for applications that require specific resolution and color settings in order to run
properly e.g. games, multimedia programs. To set the schemes:
1. Go to the Intel(R) 82852/82855 GM/GME Graphics Controller Properties control panel.
2. Click on Schemes (tab).
3. Select New to setup the scheme, and type a name in the dialog box that pops up, then click OK.
4. Click on the scheme name you had typed in the Schemes box, and choose the option you wish to use from the Video Modes
box.
5. Browse to the executable file for the application you want to set a scheme for (see sidebar).
6. You can click in the "Reset On Exit" box to return to your original settings when you exit the program, then click Save to
save the settings.
7. When you want to run the program, select it from the Schemes box and click "Invoke" to run the highlighted program in
the chosen video setting (alternatively you can select it from Display Modes by clicking on the icon option in the taskbar at
the bottom right of the screen).

Application.exe
You will need to locate the actual application executable (.exe) file, not just the shortcut. To find
the application right-click its shortcut on the desktop click Properties. Click the Shortcut (tab) and
see where the executable file is located by clicking the Find Target (button). Note the location and
you will then be able to browse to this file.

Display Devices
Besides the built-in LCD, you can also use an external monitor (CRT) as your display device. A monitor connects to the external
monitor (VGA) port (1).

Switching/Enabling Displays (Keyboard)
You can switch display devices with the Fn + Display (F7) toggle. With the video driver installed, you also can use its built-
in controls to switch the display options. To switch the display options:
1. Plug the monitor into the appropriate port.
2. Press and hold the Fn key, while simultaneously pressing the F7 key.
3. You may toggle through the options to display the LCD only, the external display alone and the LCD and the external display
together (make sure you allow time for the screens to refresh as you toggle through).

Using the Driver to Switch Displays
If you only use the keyboard toggle to switch through the display options you will not have all the
configuration options available to you. If you want to access all the options, use the driver control
panel to configure the settings.

Switching/Enabling Displays (Driver)
With the video driver installed, you can use the built-in controls to switch between the displays as follows:
1. Plug the monitor into the appropriate port.
2. Go to the Intel(R) 82852/82855 GM/GME Graphics Controller Properties control panel and select Devices (tab).
3. Choose the display option from the list on the left and click Apply (and OK to confirm the settings change).
4. The notebook will be the Primary display, and the monitor the Secondary. See the following pages for instructions on
enabling Clone and Extended Desktop modes.
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Vertical Refresh Rate
The vertical refresh rate of your monitor is important. If it is too low and/or you’re using fluorescent lighting, the screen will
appear to flicker. To reduce flickering on a monitor, use faster refresh rates (we recommend a refresh rate of 72Hz or more).
But first check your monitor’s documentation to make sure it can support the rates listed by the video driver. The default
refresh rate for monitors (without drivers) is 60Hz.

Multi-Monitor Modes
In addition to the single LCD display mode you have the following Multi-Monitor modes available when the external monitor
is attached.

Intel(R) Dual Display Clone
This mode will drive multiple displays with the same content. Use this feature to display the screen through a projector for
a presentation.

Extended Desktop
This mode allows a desktop to span multiple displays and acts as a large workspace. This creates a lot more screen area for
display. Use the Display Properties control panel to drag the monitors to match the physical arrangement you wish to use,
or you may also use the Extended Desktop Settings control panel tab in Intel(R) 82852/82855 GM/GME Graphics Controller
Properties to configure the relative size and position.

Function Key Combinations
You can use the Fn + F7 key combination to toggle through the display options:
• LCD Only
• Monitor Only
• LCD + Monitor
Make sure you give the displays enough time to refresh.

To Enable Dual Display Clone Mode:
1. Plug the monitor into the appropriate port.
2. Go to the Intel(R) 82852/82855 GM/GME Graphics Controller Properties control panel and select Devices (tab).
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3. Click the Intel(R) Dual Display Clone icon in the devices tab (Note: this option is only available when you have attached the
monitor).
4. The notebook will be the Primary display, and the monitor the Secondary.
5. Adjust the settings by clicking the Device Settings (button) if necessary.
6. Click Apply > OK and close the control panels.

To Enable Extended Desktop Mode:
1. Plug the monitor into the appropriate port.
2. Go to the Intel(R) 82852/82855 GM/GME Graphics Controller Properties control panel and select Devices (tab).
3. Click the Extended Desktop icon in the devices tab (Note: this option is only available when you have attached the monitor).
4. The notebook will be the Primary display, and the monitor the Secondary.
5. Adjust the settings by clicking the Device Settings (button) if necessary.
6. Click Apply > OK and close the control panels.

You can also enable the Extended Desktop mode from the Display Properties control panel.

Device Settings Extended Desktop
You can have different Colors, Screen Area and Monitor Refresh Rates for each display device
provided your monitor can support them.
You can drag the monitor icons to match the physical layout of your displays. Icons and programs
may also be dragged between the displays.

To Enable Extended Desktop (Display Properties)
1. Plug the monitor into the appropriate port.
2. Click Start, point to Settings (or just click Control Panel) and click Control Panel (if you are in Category View choose
Appearance and Themes).
3. Double-click Display (icon).
4. In the Display Properties dialog box, click Settings (tab).
5. Click the monitor icon (e.g. ), and make sure you have checked “Extend my Windows desktop onto this monitor.” and click
Apply.

Click the appropriate monitor icon to be able to select the option to extend the desktop on to it.
6. Use the control panel to drag the monitors to match the physical arrangement you wish to use. In the example shown the
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primary monitor is on the left; the secondary display is on the right. You can drag any icons or windows across to either display
desktop, which makes it possible to have one program visible in one of the displays, and a different program visible in the
other display.

Extended Desktop Mode
If Intel Dual Display Clone mode is currently enabled, you must use the Intel(R) 82852/82855 GM/
GME Graphics Controller Properties to switch the display.

Power Management Features
To conserve power, especially when using the battery, your notebook computer uses the ACPI power management system.
Power management conserves power by controlling individual components of the computer (the monitor and hard disk
drive) or the whole system.

Advanced Configuration and Power Interface
The ACPI interface provides the computer with enhanced power saving techniques and gives the operating system (OS)
direct control over the power and thermal states of devices and processors. For example, it enables the OS to set devices
into low-power states based on user settings and information from applications. ACPI is fully supported in Windows 2000
and Windows XP.

OS Note
Power management functions will vary slightly depending on your operating system. For more
information it is best to refer to the user’s manual of your operating system.
(Note: All pictures used on the following pages are from the Windows XP OS.)

Enabling Power Options
Power Options are enabled through the control panel in your Windows system (Power Options). With other operating
systems you may have power management available, so check your documentation.
You may conserve power through individual components or throughout the whole system.

Power Schemes
You can set your computer to conserve power through individual components by means of Power Schemes. You can also adjust
the settings for each scheme to set the monitor to turn off after a specified time, and the computer's hard disk motor to
turn off if the hard disk drive has not been accessed for a specified period of time (if the system reads or writes data, the
hard disk motor will be turned back on). The schemes may also be set to set a specified time for the system to enter Standby
or Hibernate modes.
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Resuming Operation
The system can resume from Monitor or Hard Disk Standby by pressing a key on the keyboard.

Each Windows Power Scheme will also adjust the processor performance of your machine in order to save power. This is worth
bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).
Set the Power Scheme which is most appropriate for the conditions and the applications you are using (e.g. games, 3D
applications, audio and video programs etc. usually require high CPU performance).
Choose the Home/Office scheme for maximum performance when the computer is powered from an AC power source. You
can choose the Max Battery scheme (bear in mind that this scheme may slow down the overall performance of the computer
in order to save power) for maximum power saving when the computer is battery (DC power) powered.
Windows will use Portable/Laptop as the default scheme.

Conserving Power (System)
With this function you can stop the notebook’s operation and restart where you left off. This system features Standby and
Hibernate sleep mode levels (Hibernate mode will need to be enabled by clicking the option in the Hibernate tab in the Power
Options control panel).

Hibernate Mode vs. Shutdown
Hibernate mode and Shutdown are the same in that the system is off and you need to press the power button to turn it on.
Their main difference is:
When you come back from hibernation, you can return to where you last left off (what was on your desktop) without
reopening the application(s) and file(s) you last used.
You can use either method depending on your needs.

Standby Mode vs. Hibernate Mode
If you want to stay away from your work for just a while, you can put the system on standby instead of in hibernation. It
takes a longer time to wake up the system from Hibernate mode than from Standby mode.

Standby
Standby saves the least amount of power, but takes the shortest time to return to full operation. During Standby the hard
disk is turned off, and the CPU is made to idle at its slowest speed. All open applications are retained in memory. When you
are not using your computer for a certain length of time, which you specify in the operating system, it will enter Standby
mode to save power.

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD before it turns the system off. Although
it saves the most power it takes the longest time to return to full operation. You can set your notebook to automatically
enter Hibernate mode when the battery power is almost depleted. You will need to enable Hibernate mode from the
Hibernate tab in the Power Options control panel. The system will resume from Hibernate mode by pressing the power
button.

System Resume
The system can resume from Standby mode by:
• Pressing the power button
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• Pressing a key on the keyboard
• An alarm resume that is enabled and expires
• An incoming call received on the modem (if enabled)
• Network card activity (if enabled)

Configuring the Power Button
The power button may be set to send the computer in to either Standby or Hibernate mode. In Standby mode, the LED will
flash green. In Hibernate mode the LED will be orange if AC Adapter powered, or will be off if battery powered. If you are
in a power saving mode set to save power through individual components (e.g. hard disk, monitor), the LED will remain green.

                   Power Button      Lid            Sleep/Resume(Sleep) Button

Sleep Button
You may also configure the Sleep/Resume key combination (Fn + F4) from the menu. In Windows
this is referred to as the Sleep button.

Close Cover
If you have set your computer to enter Standby mode when the lid (“when I close the lid of my
portable computer:”) of the computer is closed (the close cover switch acts as a sensor to tell
when the lid/LCD panel is closed), the system will not resume normal operation when the lid is
opened. Press a key on the keyboard to resume operation.

Battery Information
Please follow these simple guidelines to get the best use out of your battery.

New Battery
Always completely discharge, then fully charge, a new battery before using it.

Battery Life
Your notebook computer’s battery life is dependent upon many factors, including the programs you are running, and periph-
eral devices attached. Power Options (you may set low battery Alarms and actions, and check the Power Meter from the
Power Options control panel), and settings in the OS will help prolong the battery life if configured appropriately.

Caution
Danger of explosion if battery is incorrectly replaced.
Replace only with the same or equivalent type recommended by the manufacturer. Discard used
battery according to the manufacturer’s instructions.
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Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully
discharge and recharge the battery at least once every 30 days.
We recommend that you do not remove the battery yourself.

Battery FAQ
How do I completely discharge the battery?

Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer by yourself even
when you see a message that indicates the battery is critically low, just let the computer use up all of the battery power and
shut down on its own. Disable the Power Options functions in the Control Panel, especially any Alarms and Schemes. As the
battery nears the end of its life save and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light turns from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.

Conserving Battery Power
To conserve battery power:
Lower the brightness level of the LCD display. The system will decrease LCD brightness slightly to save
power when it is not powered by the AC adapter.
Close modem or communication applications when they are not being used.
Remove any unused PC Cards from the computer (PC Cards quickly use up battery power even if the
system enters sleep mode).
Disconnect any unnecessary external devices

PC Camera
A PC Camera module is provided as an optional module for this computer model. You will have the appropriate software
CD provided for your module.
After installing the driver you can run the application software by going to the CMM PC Camera item in the Start >
Programs/All Programs menu and selecting the AMCAP program.

Latest PC Camera Driver Information
Check the PC Camera CD, and any accompanying insert pages, for the latest updated information on the
PC Camera driver, which may override the information provided here.

PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in Windows.

(WinXP)
1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-click the Sounds
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& Audio Devices icon (Category View > Speech, and Audio Devices).
2. Click Advanced in the Volume tab.
3. Click Options (Volume Control) and scroll down and click Properties.
4. Click Recording (Adjust volume for) and click Microphone (check box), then click OK.
5. Make sure the Select (check box) in the Recording Control panel, under the Microphone section, is checked (boost the
volume as high as it will go).
6. Close the open windows.

(Win2000)
1. Go to the Start menu and point to Settings and click Control Panel then double-click the Sounds and Multimedia icon.
2. Click Audio (tab) and click Volume (button) in the Sound Recording menu.
3. Select Advanced Controls from the Options menu.
4. Make sure the Select (check box) in the Microphone section is checked, and boost the volume as high as it will go.
5. Close the windows.

Taking Still Pictures
You may take still pictures in the Windows XP operating system only.
Double-click the My Computer icon on the desktop, or go the Start menu and point to My
Computer, then click it.
Double-click the CMM PC Camera icon.
Click Take a new picture in the Camera Tasks box.

AMCAP
AMCAP is a video viewer useful for general purpose video viewing and testing, and can capture video files to .avi format.
1. Run the AMCAP program from the Start > Programs/All Programs > CMM PC Camera menu (it is recommended that
you set the capture file before the capture process - see Set Capture File below).
2. Go to the Capture menu heading (if you wish to capture audio make sure that the Capture Audio option is ticked) and select
Start Capture.
3. On the first run of the program (if you have not set the captured file) you will be asked to choose a file name and size
(see the sidebar - Pre-Allocating File Space) for the captured file.
4. Click OK to start capturing the video, and press Esc to stop the capture. 5. If you wish to, you may go to the File menu and
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select Save Captured Video As..., choose a file name and location, then click Open (you can view the file using the Windows
Media Player).

Set Capture File
In AMCAP program you will only be asked to set the capture file name on the first run of the program. When you run the
program the next time the file will automatically be overwritten with the newly captured file. To avoid overwriting files
you can go to the Set Capture File.. option in the File menu, and set the file name and location before capture. Set the name
and location then click Open (you can choose Cancel to ignore the file size if prompted).

Pre-Allocating File Space
You may pre-allocate the file size for the capture file in the AMCAP program. You can choose to
ignore this by clicking Cancel.
Pre-allocating space on the hard disk can improve the capture quality (particularly of large
capture files), by reducing the amount of work the hard disk has to do in finding space for the
video data as it is being captured.
You may find it helpful to defragment the HDD before capture.

Eliminating Screen Flicker
If you find that the video screen in the AMCAP program is flickering, you can try to adjust the option from the Video Capture
Filter options.
1. Run the AMCAP program from the Start > Programs/All Programs > CMM PC Camera menu.
2. Go to Options and scroll down to select “Video Capture Filter...”.
3. You can choose either 50Hz or 60Hz from the No Flicker box.

Intel PRO/Wireless Mini PCI WLAN Module
Either an Intel PRO/Wireless 2100 (802.11b) OR 2200BG (802.11b/g) Mini PCI WLAN module is supplied as a standard feature
for this computer model. You will have the appropriate software CD provided for your module, depending on your purchase
option.
Before installing the Intel PRO/Wireless 2100 OR 2200BG Mini PCI WLAN driver, make sure that the Wireless LAN module
is on (the LED will be green). Use the Fn + F11 to toggle power to the Wireless LAN module.
To get help on the network settings you can view the User Guides from the Intel PRO CD-ROM.

Intel PRO/Wireless 2100 (802.11b)
You can view the User Guides by inserting the Intel PRO CD-ROM and clicking Wireless LAN Adapters (button) > View User
Guides (button).

Intel PRO/Wireless 2200BG (802.11b/g)
You can view the User Guides by inserting the Intel PRO CD-ROM and clicking View User Guides (button).
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Bluetooth & WLAN Modules
Do not try to use the Wireless LAN module and the Bluetooth module at the same time, as this
may cause a communication conflict.

Bluetooth Module
A Bluetooth module is provided as an optional module for this computer model. You will have the appropriate software CD
provided for your module, if you have included the Bluetooth module in your purchase option. Before installing the Bluetooth
driver, make sure that the module is on (the LED will be orange). Use the Fn + F12 to toggle power to the Bluetooth module.

Bluetooth Manual and Application Note
Configuration information for the Bluetooth module is contained in the Manual and Application note (in Adobe Acrobat .pdf
format) on the Bluetooth CD-ROM. You may need to install the Acrobat Reader program first (click the Acrobat Reader item
when you insert the Bluetooth CD-ROM and follow the on-screen instructions). Insert the Bluetooth CD-ROM and click
Readme to access the Manual and Application note.

Bluetooth Driver Audio Setup (Win2000)
After installing the Bluetooth driver in Windows 2000 you may no longer hear any sound, nor see the Volume icon in the
taskbar. If this is the case then follow this procedure:
1. Go to the Sounds & Multimedia Control Panel (Start Menu and point to Settings and click Control Panel then double-click
the Sounds & Multimedia icon).
2. Click the Audio tab.
3. In the Sound Playback and Sound Recording menus choose Realtek AC97 Audio.
4. Click the Sounds tab and make sure that the tickbox to “Show volume control on the taskbar” is ticked.
5. Click OK.

Bluetooth Control Panel Options
You may need to change some control panel options after installing the Bluetooth driver:

Audio
1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-click the Sounds
& Audio Devices/Sounds & Multimedia icon (Category View > Speech, and Audio Devices).
2. Click Audio (tab) and make sure that the “Default device:” is Realtek AC97 Audio.

Hyper Terminal
1. Go to Start menu and click Programs/All Programs, then point to Accessories > Communications > HyperTerminal.
2. Double-Click your connection, and make sure you have selected “Connect Using:” Smart Link 56K Voice Modem.
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FAX (WinXP)
1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-click the Printers
and Faxes icon (Category View > Printers and Other Hardware).
2. Double-click your fax icon to bring up the Fax Console.
3. Click the Tools menu and scroll down to “Configure Fax...”.
4. Click Next > Next and make sure that the fax device is the Smart Link 56K Voice Modem.

FAX (Win2000)
1. Go to the Start menu and point to Settings and click Control Panel, then double-click the Fax icon.
2. Click Advanced Options (tab) and click the Open Fax Service Management Console (button).
3. Click Devices in the Tree window on the left.
4. The fax devices will be displayed in the right window, with the device with the highest priority displayed at the top.
5. Select the Smart Link 56K Voice Modem and use the arrows to move it to the top of the priority list, then close the windows.

BIOS Utilities

The Power-On Self Test (POST)
Each time you turn on the computer, the system takes a few seconds to conduct a POST, including a quick test of the on-board
RAM (memory).
As the POST proceeds, the computer will tell you if there is anything wrong. If there is a problem that prevents the system
from booting, it will display a system summary and prompt you to run Setup.
If there are no problems, the Setup prompt (Press <F2> to enter SETUP) will disappear and the system will load the
operating system. Once that starts, you can’t get into Setup without rebooting.

Post Screen
1. BIOS information
2. CPU type
3. Memory status
4. Enter Setup prompt appears only during POST
Note: The POST screen as pictured is a guideline only. The POST screen on your computer may
appear slightly different.

Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong with your system. Take the computer
to your service representative or authorized service center as soon as possible.
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Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the problem (make a note of this message!)
followed by the prompt:
• Press <F1> to resume,
• <F2> to enter Setup
Press F1 to see if the boot process can continue. It may work, without the correct configuration.
Press F2 to run the Setup program and try to correct the problem. If you still get an error message after you change the
setting, or if the “cure” seems even worse, call for help.

The Setup Program
The Setup program tells the system how to configure itself and manage basic features and subsystems (e.g. port configu-
ration).

Entering Setup
To enter Setup, turn on the computer and press F2 during the POST or Logo startup screen.
The prompt (“Press F2 to Enter Setup”) is usually present for a few seconds after you turn on the system. If you get a
“Keyboard Error” (usually because you pressed F2 too quickly) just press F2 again. If the computer is already on, reboot using
the Ctrl + Alt + Delete combination and then hold down F2 (or Enter when you see the Logo startup screen) when prompted.
Setup’s main menu will appear.

Setup Screens
The following pages contain additional advice on portions of the Setup. Along the top of the screen is a menu bar with menu
headings. When you select a heading, a new screen appears. Scroll through the features listed on each screen to make changes
to Setup.

Main Menu
System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., oo = midnight; 13 = 1 pm). If you can change the date and time settings in
your operating system, you will also change these settings. Some applications may also alter data files to reflect these
changes.

Primary Master (Main Menu)
Pressing Enter under opens the sub-menu to show the configuration of the HDD that fits into the computer’s HDD bay. These
items are configured automatically for you.

Secondary Master (Main Menu)
Pressing Enter in this menu opens the sub-menu to show the configuration of the CD device. These items are configured
automatically for you.
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System Memory, Extended Memory (Main Menu)
These items contain information on the system memory. These two items are not user configurable.

Advanced Menu

Installed O/S: (Advanced Menu)
This setting tells the computer what kind of operating system you’re using.

Reset Configuration Data: (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have installed a new add-on which has reconfigured
the system, resulting in such a serious system conflict that the operating system is unable to boot.

Large Disk Access Mode: (Advanced Menu)
Select “Other” if you are using systems such as Novell, UNIX etc. Select “DOS” (default) if you are using Windows.

Local Bus IDE adapter: (Advanced Menu)
This item allows you to configure the IDE bus which controls the hard disk and optical devices. It is set to “Both” by default.

USB All Devices Control/2.0 Function Control (Advanced Menu)
This option allows you to disable/enable all the USB ports if necessary (USB All Devices Control), or just functionality for USB
2.0 (USB 2.0 Function Control) if necessary. These are all “Enabled” by default.

Legacy USB Support: (Advanced Menu)
Choose “Enabled” if you intend to use USB devices in systems which do not normally support USB functionality (e.g. DOS).
The default setting is “Enabled” and does not need to be changed if you intend to use your USB devices in Windows.

FIR Control: (Advanced Menu)
Enable or disable control for the infrared transceiver here.

Intel On-Screen Branding Logo
This menu item allows you to enable/disable the Boot Logo Screen as the computer starts up (it is “Disabled” by default).
This will affect what sort of POST screen you appears.

LED of TouchPad control (Advanced Menu)
Set the LED on the central button of the TouchPad here to be on (“Enabled”) or off (“Disabled”).
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Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Setup utility. This will not affect access to the computer OS (only the Setup utility).
You can set the user password from the sub-menu (Set User Password) after you have set the supervisor password.

Set User Password (Security Menu)
You can set a password for user mode access to the Setup utility. This will not affect access to the computer OS (only the Setup
utility). Many menu items in the Setup utility cannot be modified in user mode. You can only set the user password after
you have set the supervisor password.

Note: To clear existing passwords press Enter and type the existing password. Then press Enter for
the new password (without typing any password entry) and Enter again to confirm the password
clearance.

Boot Menu

Boot Menu
When you turn the computer on it will look for an operating system (e.g Windows XP) from the devices listed in this menu,
and in this order. If it cannot find the operating system on that device, it will try to load it from the next device in the order
specified in the Boot Menu. Boot devices usually are hard drives, floppy drives (removable devices), and CD-ROMs.
When you specify a device as a boot device on the Boot Menu, it requires the availability of an operating system on that
device. Most home computers come with an operating system already installed on “Drive C:”.
If you wish to boot from a CD-ROM you will need to add it to the boot order.
As a general rule the order below is recommended:
1. Removable Devices (usually external USB floppy disks)
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2. CD-ROM Drive
3. Hard Drive
In everyday use you will usually boot from the hard drive, however there may be occasions when it is advantageous to boot
from a floppy disk (e.g. an external USB floppy disk drive) or CD-ROM.
You can also boot from a network (LAN) if required.

Configuring the Network Boot Protocol
The system supports booting from FDD, HDD, CD or LAN (network). To boot from a network. Follow the full instructions in
the sidebar to configure the network boot protocol.

Exit Menu

Choosing to “Discard Changes” or “Exit Discarding Changes” will wipe out any changes you have made to the Setup. You can
also choose to restore the original Setup Defaults which will return the Setup to its original state and erase any previous
changes you have made in a previous session.
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Troubleshooting

Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer appears not
to be working.
• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, make sure it is
actually working. Check the LED Power Indicators to see the computer’s power status.
• Connections - Check all the cables to make sure that there are no loose connections anywhere.
• Power Savings - Make sure that the system is not in Hibernate or Standby mode by pressing the Fn + F4 key combination,
or by pressing the power button, to wake-up the system.
• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the brightness.
• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.
• Boot Drive - Make sure there are no floppy disks in any attached floppy drives when you start up your machine (this is
a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / “Remove disks or other
media. Press any key to restart”).

Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to note
the serial numbers if you are storing them out of their original cases, e.g. in a CD wallet.
• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these programs to run at times
when you are not using your computer. You can use those that are provided free with your OS, or buy the more powerful
dedicated programs to do so.
• Write down your passwords and keep them safe (away from your computer).
• Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just brief notes).

Warranty
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way,
may violate your warranty.

Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses to look for) up
to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause you
to lose data. Anti-Virus programs are commercially available and the definitions file updates are usually downloadable
directly from the internet.
• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-mail attachments
so take care when opening any attached file. You can configure most Anti-Virus programs to check all e-mail attachments.
Note: You should also beware of files from people you know as the virus may have infected an address book and been
automatically forwarded without the person’s knowledge.
• Keep a “Boot Floppy Disk” (this disk provides basic information which allows you to startup your computer) handy. You may
refer to your OS’s documentation for instructions on how to make one, and many Anti-Virus programs will also provide such
a disk (or at least instructions on how to make one).
• Thoroughly check any recent changes you made to your system as these changes may affect one or more system
components, or software programs. If possible, go back and undo the change you just made and see if the problem still occurs.
• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found;
Example - if your computer has many devices plugged into its ports, and a number of programs running, then it will be
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difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all the
peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where necessary) will
often find the source of a problem, although this may be time consuming.

Power

Problem Possible Cause - Solution

You turned on Battery missing / incorrectly installed. Check the battery bay, make sure the battery
the power but it doesn’t work. is present and seated properly (the design of the battery only allows it to go in

one way). Make sure there’s nothing interfering with the battery contacts.

The Battery LED power indicator Low Battery. Plug in the AC power source. If the computer doesn’t start up
is blinking orange. immediately, turn it off then on again.

You are losing battery The system is using too much power. If your OS has a Power Options scheme check
power too quickly. its settings. You may also be using a PC Card device that is drawing a lot of power.

Actual battery operating time The battery has not been fully discharged before being recharged. Make sure the
is shorter than expected. battery is fully discharged and recharge it completely before reusing.

Power Options have been disabled. Go to the Control Panel in Windows and re-
enable the options.
A peripheral device or PC Card is consuming a lot of power. Turn off the unused
device to save power.

The computer feels too hot. Make sure the computer is properly ventilated and the vents/fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn it
off for an hour. Make sure the computer isn’t sitting on a thermal surface. Make
sure you’re using the correct adapter.
Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the vents/intakes to be blocked.

Display

Problem Possible Cause - Solution

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key combination,
Fn + F4.
The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you’re connected to an external monitor, make sure it’s
plugged in and turned on. You should also check the monitor’s own brightness and
contrast controls.
The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.
The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the external You haven’t installed the video driver and configured it appropriately from the
monitor I have plugged in and Control Panel.
powered on.
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Audio & CD Device

Problem Possible Cause - Solution

The sound cannot be heard or The volume might be set too low. Check the volume control in the Volume Control
the volume is very low. Panel in the Windows taskbar, or use the key combination Fn + F5 and F6 to

adjust.

The compact disc cannot be read. The compact disc is dirty. Clean it with a CD-ROM cleaner kit.

The compact disc tray will not open The compact disc is not correctly placed in the tray. Gently try to remove the disc
when there is a disc in the tray. using the eject hole.

The DVD regional codes can no The code has been changed the maximum 5 times.
longer be changed.

Media Warning When manually ejecting a CD/DVD, DO NOT use a sharpened pencil or similar object
which may break, and become lodged in the hole.

Keyboard

Problem Possible Cause - Solution

Unwelcome numbers appear If the LED is lit, then Num Lock is turned ON
when typing.

Other Keyboards If your keyboard is damaged or you just want to make a change, you can use any
standard USB keyboard. The system will detect and enable it automatically.
However special functions/hot keys unique to the system’s regular keyboard may
not work.

Operation

Problem Possible Cause - Solution

The system freezes or the screen The system’s power saving features have timed-out. Use the AC adapter, press the
goes dark. sleep (Fn + F4) key combination, or press the power button if no LEDs are lit.

A software conflict made the system “crash”. Consult your OS manual. As a last
resort, since you will lose any unsaved data, try to reboot the system or if that
doesn’t work, turn the computer off and on again.

The system never goes into Power Options features are not enabled. Go to the Windows Power Options menu
a power saving mode. and enable the features you prefer. Make sure you have enabled Hibernate mode

from the control panel.

Modules

Problem Possible Cause - Solution

The Wireless LAN or Bluetooth The modules are off. Check the LED indicator to see if the modules are on or off. If
modules cannot be detected. the LED indicator is off, then press the WLAN or Bluetooth Module On/Off key

combination in order to enable the modules.

The Wireless LAN or Bluetooth The driver(s) for the module(s) have not been installed. Make sure you have
modules cannot be configured. installed the driver for the appropriate module.
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Specifications

Latest Specification Information
The specifications listed in this Appendix are correct at the time of going to press. Certain items
(particularly processor types/speeds) may be changed or updated due to the manufacturer's
release schedule. Check with your service center for details.

Processor Types
Intel® Pentium® M Processor (478-pin) µFCPGA Package (µ0.13) 0.13 Micron Process Technology, 1MB On-die L2 Cache &
400MHz Front Side Bus - 1.3/1.4/1.5/1.6/1.7 GHz
Intel® Pentium® M Processor (478-pin) µFCPGA Package (µ0.09) 0.09 Micron Process Technology, 2MB On-die L2 Cache &
400MHz Front Side Bus - 1.5A/1.6A/1.7A/1.8 GHz
Intel® Celeron® M Processor (478-pin) µFCPGA Package (µ0.13) 0.13 Micron Process Technology, 512KB On-die L2 Cache &
400MHz Front Side Bus - 1.2/1.3/1.4 GHz
Intel® Celeron® M Processor (478-pin) µFCPGA Package (µ0.09) 0.09 Micron Process Technology, 512KB On-die L2 Cache &
400MHz Front Side Bus - 1.3/1.4 GHz

Core Logic
Intel 855GME + Intel 82801DBM (ICH4-M) Chipset

Structure
2 Spindle, Compliant PC2001 Standard

Security
Security (Kensington® Type) Lock Slot, BIOS Password

Memory
One 200 Pin SODIMM Socket Supporting DDR266/ DDR333, Expandable Memory up to 1 GB, Supporting 128MB/ 256MB/
512MB/ 1GB SODIMM RAM

Modules
BIOS 4MB Flash ROM, Phoenix BIOS

LCD
12.1" WXGA TFT LCD 16:9 Panel

Display
Intel 855GME Integrated Video, Integrated High Quality 3D Graphics Engine Accelerator, Supporting Dual Analog Indepen-
dent Display
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Storage
One of the Following Changeable 12.7mm(h) Drive Options - CD-ROM/ DVD-ROM/ CD-RW/DVD-ROM & CD-RW Combo/
DVD-RW/ DVD+RW/ Dual DVD, One Changeable 2.5" 9.5mm(h) Hard Disk Drive, Supporting ATA 33/66/100 IDE Interface

Audio
AC’97 2.2 Compliant Device, 3D Stereo Enhanced Sound System, Compatible Sound Blaster PRO™, Built-In Microphone, Built-
In 2 Speakers

Keyboard & Pointing Device
Winkey Keyboard, Built-In TouchPad

PCMCIA
One Type II PCMCIA 3.3V/5V Socket Supporting CardBus

Interface & Communication
Two USB 2.0 Ports, One Infrared Transceiver (IrDA 1.1 FIR/SIR/ASKIR), Infrared Transfer 1cm ~ 1M Operating Distance, 115.2K
bps SIR, 4M bps FIR, One VGA Monitor (VGA) Port, One Headphone Jack, One Microphone Jack, One DC-In Jack, One RJ-11 Jack
(Modem), One RJ-45 Jack (Local Area Network), 10/100 BASE-T Compatible, Video Camera Module (Factory Option),
Integrated V.90/56K MDC Modem (V.92 Compliant), MDC & Bluetooth Combo Module (Factory Option), Intel/PRO Wireless
2100 Mini PCI I/F 802.11b Wireless LAN Module (Optional) OR Intel/PRO Wireless 2200BG Mini PCI I/F 802.11b/g Wireless
LAN Module (Optional)

Indicators
LED Indicators (Wireless On/Off, HDD Activity, Suspend/Power On/AC-In, Battery Charging/Battery Full, Num Lock, Caps Lock,
Scroll Lock)

Power Management
Supports ACPI v1.0b/2.0, Supports Hibernate/Standby Modes, Supports Battery Low Sleep, Supports Resume From Modem
Ring

Power
Full Range AC Adapter - AC-In 100~240V, 50~60Hz, DC Output 65W; Standard - Easy Changeable, 4 Cell, 4800mAH, 35.5 Whrs,
Main Battery Smart Li-Ion; Optional - Easy Changeable, 8 Cell, 4400mAH / 4800mAH, 65.2 / 71 Whrs, Main Battery Smart
Li-Ion

Environmental Spec
Temperature

Operating: 5°C ~ 35°C, Non-Operating: -20°C ~ 60°C
Relative Humidity

Operating: 20% ~ 80%, Non-Operating: 10% ~ 90%
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Physical Dimensions & Weight
295mm (w) * 235mm (d) * 26-33mm (h)
1.7kg without Battery

Optional
DVD-ROM Drive Module, CD-RW Drive Module, DVD/CD-RW Combo Drive Module, DVD-RW Drive Module, DVD+RW Drive
Module, Dual DVD Drive Module, Software DVD Player, Video Camera Module, MDC & Bluetooth Combo Module, Intel/PRO
Wireless 2100 Mini PCI I/F 802.11b, Wireless LAN Module OR Intel/PRO Wireless 2200BG Mini PCI I/F 802.11b/g Wireless LAN
Module
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